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Using This Documentation

This installation guide contains installation and configuration procedures for
Windows operating systems. You perform these procedures to bring the server to a
configurable and usable state.

Note – The Sun Server X2-4 was formerly named the Sun Fire X4470 M2 server. This
former name might still appear in the software. The new product name does not
indicate any change in system features or functionality.

This document is intended for system administrators, network administrators, and
service technicians who have an understanding of server systems.

■ “Getting the Latest Software and Firmware” on page vii

■ “About This Documentation” on page viii

■ “Related Documentation” on page viii

■ “Feedback” on page viii

■ “Support and Accessibility” on page ix

Getting the Latest Software and
Firmware
Firmware, drivers, and other hardware-related software for each Oracle x86 server,
server module (blade), and blade chassis are updated periodically.

For instructions, see Chapter 5.
vii



About This Documentation
This documentation set is available in both PDF and HTML formats. A PDF version
that includes all information on a particular topic subject (such as hardware
installation or product notes) can be generated by clicking the PDF button in the
upper left corner of the HTML page.

Related Documentation

Feedback
You can provide feedback on this documentation at:

http://www.oracle.com/goto/docfeedback

Documentation Link

All Oracle documentation http://www.oracle.com/documentation

Sun Server X2-4 http://www.oracle.com/pls/topic/lookup?ctx=
SunServerX2-4

Oracle Integrated Lights
Out Manager (ILOM) 3.0

http://www.oracle.com/pls/topic/lookup?ctx=
ilom30

Oracle Integrated Lights
Out Manager (ILOM) 3.1
(for Sun Server X2-4
Software Release 1.3 and
above)

http://www.oracle.com/pls/topic/lookup?ctx=
ilom31

Oracle Hardware
Installation Assistant

http://www.oracle.com/pls/topic/lookup?ctx=
hia
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Support and Accessibility

Description Links

Access electronic support
through My Oracle Support

http://support.oracle.com

For hearing impaired:
http://www.oracle.com/accessibility/support.
html

Learn about Oracle’s
commitment to accessibility

http://www.oracle.com/us/corporate/accessibi
lity/index.html
Using This Documentation ix
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PART I Windows Server Installations

This section lists the topics that describe how to install the Windows 2008 (SP2
or R2) operating systems on your server.

Description Links:

Novice or Experienced Users: Use Oracle
Hardware Installation Assistant to perform an
assisted installation of the Windows operating
system. Oracle Hardware Installation
Assistant provides the appropriate system
drivers and platform-specific software.

• Chapter 1, Assisted OS Installation
With Oracle Hardware Installation
Assistant

Experienced Users. Manually install the
Windows operating system and the required
system drivers.

• Chapter 2, Getting Started
• Chapter 3, Windows Server 2008

Installation
• Chapter 4, Post Installation of Windows

Server 200

Experienced Users. Reference content for
manual Windows operating system
installations.

• Appendix A, Supported Installation
Methods

• Appendix B, Supported Operating
Systems

• Appendix C, BIOS Defaults For New
Installs

• Appendix D, Incorporating Device
Drivers Into WDS Images





CHAPTER 1

Assisted OS Installation With Oracle
Hardware Installation Assistant

The Oracle Hardware Installation Assistant makes operating system installation
easy. With the Oracle Hardware Installation Assistant, all you need to begin is a
licensed copy of Linux or Windows OS distribution media supported for your
server. All software and required server-specific drivers are supplied by Oracle
Hardware Installation Assistant. With a graphical wizard interface and flexible
installation options, Oracle Hardware Installation Assistant brings simplicity, speed,
and reliability to your server deployments.

To use Oracle Hardware Installation Assistant, simply boot the program from the
server's CD drive, a USB flash drive, or from a network image. Check for the latest
program updates available. Select your OS distribution from the menu and follow
the on-screen instructions. Oracle Hardware Installation Assistant scans your system
to ensure that it has the drivers it needs to configure your server components[1]. It
also provides you the option of having the program check for the latest drivers
available. Oracle Hardware Installation Assistant will prompt you for the
appropriate media as needed and any other required information during the OS
installation process (such as license keys).

Note – [1] Some option card drivers are downloaded to the server, but require
manual installation. Feature enhancements are made to Oracle Hardware Installation
Assistant regularly; therefore, you should check the Oracle Hardware Installation
Assistant information page for the latest updates and supported features:
http://www.oracle.com/goto/hia.

Topics discussed in this chapter include:

■ “Oracle Hardware Installation Assistant Task Overview” on page 4

■ “How to Obtain Oracle Hardware Installation Assistant” on page 4

■ “Oracle Hardware Installation Assistant Documentation Resources” on page 5
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Oracle Hardware Installation Assistant
Task Overview
You can perform the following tasks using Oracle Hardware Installation Assistant:

Note – The supported Oracle Hardware Installation Assistant installation and
recovery tasks listed below are server-dependent and might vary.

■ Perform an assisted installation of a Linux or Windows operating system on your
Sun x86 server from Oracle. Oracle Hardware Installation Assistant provides the
appropriate drivers and platform-specific software, eliminating the need to create
a separate driver disk.

■ Optionally create RAID-0 or RAID-1 volumes on internal storage devices.

■ Optionally upgrade your system’s Oracle Integrated Lights Out Manager (ILOM)
service processor (SP), BIOS, and storage device firmware (regardless of the OS on
your server).

■ Optionally update your Oracle Hardware Installation Assistant session with the
latest firmware and drivers.

■ Optionally recover from a corrupt or inaccessible Oracle ILOM service processor.

How to Obtain Oracle Hardware
Installation Assistant
Oracle Hardware Installation Assistant ships with the Sun Server X2-4 and is
available in CD format or a web download. Regular updates are made available to
ensure that the latest OS versions are supported. You can download, per your
platform server, the latest version of Oracle Hardware Installation Assistant at:

https://support.oracle.com
4 Sun Server X2-4 Installation Guide for Windows Operating Systems • September 2012
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Oracle Hardware Installation Assistant
Documentation Resources
If you have determined that you want to install a Windows or Linux operating
system on your Sun x86 server using Oracle Hardware Installation Assistant, refer to
the following document for detailed installation instructions:

■ Oracle Hardware Installation Assistant 2.5 User’s Guide for x86 Servers at:

http://www.oracle.com/pls/topic/lookup?ctx=hia
Chapter 1 Assisted OS Installation With Oracle Hardware Installation Assistant 5
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CHAPTER 2

Getting Started

This chapter describes how to get started installing the Microsoft Windows Server
2008 SP2 and the Microsoft Windows Server 2008 R2 operating systems manually on
your server.

Note – The term “manually” refers to performing the installation by following the
instructions provided in Chapters 2 through 4 of this guide, and not using the Oracle
Hardware Installation Assistant. If you prefer to perform an assisted Windows
installation by using Oracle Hardware Installation Assistant, see Chapter 1 of this
guide.

Topics discussed in this chapter include:

■ “Supported Windows Server Operating Systems” on page 7

■ “Windows Installation Prerequisites” on page 8

■ “Windows Server Installation Task Overview” on page 10

■ “SAS PCIe HBAs Requiring LSI Mass Storage Driver for Windows Server 2008
SP2” on page 11

Supported Windows Server Operating
Systems
The Sun Server X2-4 supports the following Microsoft Windows operating systems:
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For a complete and updated list of all the supported operating systems on the Sun
Server X2-4, go to the Sun x86 Servers web site and navigate to the Sun Server X2-4
page:

http://www.oracle.com/technetwork/server-storage/sun-
x86/overview/index.html

Windows Installation Prerequisites
Refer to the following important prerequisites before beginning the Windows Server
2008 operating system installation on your server.

Windows OS Edition

• Windows Server 2008 SP2 • Standard Edition (64-bit)
• Enterprise Edition (64-bit)
• Datacenter edition (64-bit)

• Windows Server 2008 R2 • Microsoft Windows Server 2008 R2, SP1 (64-bit)
• Standard Edition (64-bit)
• Enterprise Edition (64-bit)
• Datacenter edition (64-bit)

TABLE 2-1 Windows Installation Prerequisites

Requirement Description For more information, see:

Server is set up and
operational

The server is mounted and powered-on in the rack and
communication to the SP has been established.

• Sun Server X2-4
Installation Guide

Established
deployment method
that enables you to
boot the Windows
install program

Guidelines for selecting a local or remote deployment
method for installing a Windows operating system.

• Appendix A
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RAID volume creation If you want to include your boot drive as part of a RAID
configuration, you need to configure a RAID volume on
it. Use the LSI integrated RAID controller setup utility
before you install the operating system.
If you are using the optional SGX-SAS6-R-INT- Z host
bus adapter (HBA), you must use the LSI integrated
RAID controller setup utility to configure a RAID
volume. For instructions, see the LSI MegaRAID SAS
Software User’s Guide.
If you are using the optional SGX-SAS6-INT-Z HBA, you
must use the BIOS Configuration Utility to configure a
RAID volume. For instructions, see the Sun Storage 6 Gb
SAS PCIe HBA Internal Installation Guide.

• LSI MegaRAID Software
SAS User’s Guide at:
http://www.lsi.com
/support/sun/

• Sun Storage 6 Gb SAS
HBA Internal Installation
Guide at:
http://docs.oracle
.com/cd/E19221-
01/E22410/E22410.p
df

Verification of BIOS
settings for new OS
installations

Prior to installing the Windows Server 2008 operating
system, you should verify that the BIOS factory-default
properties are set.

• Appendix C

Installation of
server-specific device
drivers and optional
supplemental software

After performing the Windows Server 2008 installation,
you might need to:
• Install server-specific device drivers to support

additional hardware.
Note the Windows 2008 SP2 does not include the LSI
mass storage drivers for the SAS PCIe host bus
adapters (HBAs). If you have a SAS PCIe HBA option
installed, the LSI mass storage driver for the SAS PCIe
HBA option must be made accessible from the tools
and drivers firmware DVD during installation. For a
list of supported SAS PCIe HBAs, see TABLE 2-2.

• Install Windows Server optional supplemental software
that is available for your x86 server.

• Chapter 4
• “SAS PCIe HBAs

Requiring LSI Mass
Storage Driver for
Windows Server 2008
SP2” on page 11

Incorporate server-
specific device drivers
in a WIM image

Advanced users can incorporate the post installation
system device drivers into WDS boot and install images.

• Appendix D

Access to late-
breaking information
and patches for OS
installations

Review the Sun Server X2-4 Product Notes for late-
breaking information about supported operating system
software and patches.

• Sun Server X2-4 Product
Notes

TABLE 2-1 Windows Installation Prerequisites (Continued)

Requirement Description For more information, see:
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Windows Server Installation Task
Overview
To manually install Windows Server 2008 (SP2 or R2), complete the following
procedures in order:

1. Obtain the tools and drivers firmware by downloading the latest drivers and
utilities available for your Sun x86 server platform as described in Chapter 5.

The install program for the Windows Server 2008 SP2 does not include the LSI
drivers for the Sun Storage SAS PCIe HBA options. Therefore, if you have a SAS
PCIe HBA configured on your server and you are installing Windows 2008 SP2,
the LSI mass storage driver for the SAS PCIe HBA option must be made
accessible from the tools and drivers firmware DVD during the installation
process.

For a list of SAS PCIe HBAs supported on the Sun Server X2-4, see “SAS PCIe
HBAs Requiring LSI Mass Storage Driver for Windows Server 2008 SP2” on
page 11.

Note – Optionally, advanced users might prefer to incorporate the drivers into WDS
images. For instructions on how to incorporate the drivers into WDS images, see
Appendix D.

2. Choose and set up an installation method for deploying the Windows Server
installation as described in Appendix A.

3. Follow the instructions for performing a manual installation of the Windows
Server operating system as described in Chapter 3.

4. Follow the instructions for performing the Windows Server post installation tasks
as described in Chapter 4.
10 Sun Server X2-4 Installation Guide for Windows Operating Systems • September 2012



SAS PCIe HBAs Requiring LSI Mass
Storage Driver for Windows Server 2008
SP2
TABLE 2-2 identifies the SAS PCIe host bus adapter options that are supported on the
Sun Server X2-4. If you have one of these SAS PCIe HBA options configured on your
server and you are installing Windows Server 2008 SP2, you will need to load the
LSI mass storage driver for the PCIe HBA option from the tools and drivers
firmware DVD during installation.

Note – To determine which HBA option cards are supported and available for
purchase on the Sun Server X2-4, go to the Sun x86 Servers web site and navigate to
the Sun Server X2-4 page: http://www.oracle.com/technetwork/server-
storage/sun-x86/overview/index.html.

Instructions for loading the LSI mass storage driver during the Windows Server 2008
SP2 installation are provided in Step 8 of the “Install Windows Server 2008 (SP2 or
R2) Using Local or Remote Media” on page 14.

If you do not have the tools and drivers firmware, you can download the ISO image
for the tools and drivers firmware. For details, see Chapter 5.

TABLE 2-2 Supported SAS PCIe HBAs Requiring LSI Mass Storage Driver

Supported SAS PCIe HBAs Option Number Driver Required During Installation

Sun Storage 6 Gb SAS PCIe RAID
HBA, Internal

SG-SAS6-R-INT-Z LSI MegaRAID SAS 92xx-xx

Sun Storage 6 Gb SAS PCIe HBA,
Internal

SG-SAS6-INT-Z LSI Adapter SAS 2008 Falcon

Sun Storage 6 Gb SAS PCIe HBA,
External

SG-SAS6-EXT-Z LSI Adapter SAS 2008 Falcon
Chapter 2 Getting Started 11
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CHAPTER 3

Installing Windows Server 2008

This chapter provides information about manually installing the Windows Server
2008 SP2 or Windows Server 2008 R2 operating system.

Note – The term “manually” refers to performing the installation by following the
instructions provided in Chapters 2 through 4 of this guide, and not using the Oracle
Hardware Installation Assistant. If you prefer to perform an assisted Windows
installation by using Oracle Hardware Installation Assistant, see Chapter 1 of this
guide for details.

This chapter includes the following topics:

■ “Before You Begin” on page 13

■ “Installing Windows Server Using Local or Remote Media” on page 14

■ “Windows Server Installation Using a PXE Network Boot” on page 24

Before You Begin
Ensure that the following requirements are met before you proceed with the
instructions in this chapter for manually installing the Windows Server operating
system.

■ All applicable installation prerequisites for installing an operating system should
have been met. For further information about these prerequisites, see “Windows
Installation Prerequisites” on page 8.

■ An installation method (for example: console output, boot media, and install
target) should have been chosen and established prior to performing the
installation. For more information about these setup requirements, see Appendix
A.
13



■ Use the Microsoft Windows Server 2008 (SP2 or R2) operating system
documentation in conjunction with the Windows Server operating system
instructions provided in this chapter. You can obtain a copy of Microsoft’s
Windows Server 2008 installation documentation at:
http://www.microsoft.com/windowsserver2008/en/us/product-
documentation.aspx

After completing this procedure, you should review and perform the required post
installation tasks described later in this guide. For more details, see Chapter 4.

Installing Windows Server Using Local
or Remote Media
The procedure in this section describes how to boot the Windows Server 2008 (SP2
or R2) operating system from local or remote media. It assumes that you are booting
the Windows installation media from one of the following sources:

■ Windows Server 2008 SP2 or Windows Server 2008 R2 (or subsequent release) CD
or DVD

■ Windows Server 2008 SP2 or Windows Server 2008 R2 (or subsequent release) ISO
image

Note – The Windows Server 2008 (SP 2 or R2) ISO image can be used for remote
installation or for creating an installation CD or DVD.

Note – If you are booting the installation media from a PXE environment, refer to
“Windows Server Installation Using a PXE Network Boot” on page 24 for
instructions.

▼ Install Windows Server 2008 (SP2 or R2) Using
Local or Remote Media
1. Ensure that the installation media is available to boot.

■ For Distribution CD/DVD. Insert the Windows 2008 Distribution media (CD
labeled number 1 or the single DVD) into the local or remote USB CD/DVD-
ROM drive.
14 Sun Server X2-4 Installation Guide for Windows Operating Systems • September 2012
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■ For ISO image. Ensure that the ISO images are available and that the Oracle
ILOM Remote Console application is aware of the first ISO image location.

For additional information about how to set up the installation media, see
“Boot Media Options for Performing the OS Installation” on page 45.

2. Reset or power on the server.

Note – The following steps use Oracle ILOM 3.1 command syntax. If you are using
Oracle ILOM 3.0, refer to the Oracle ILOM 3.0 Documentation Collection at
http://www.oracle.com/pls/topic/lookup?ctx=ilom30.

For example:

■ From the Oracle ILOM web interface, select Host Management > Power
Control in the navigation tree. Then, select Power Cycle from the Select Action
list box and click Save.

■ From the local server, press the Power button (approximately 1 second) on the
front panel of the server to power off the server, then press the Power button
again to power on the server.

■ From the Oracle ILOM CLI, type: reset /System

The BIOS screen appears.

Note – The next events occur very quickly; therefore, focused attention is needed
for the following steps. Watch carefully for these messages as they appear on the
screen for a brief time. You might want to enlarge the size of your screen to eliminate
scroll bars.

3. In the BIOS power-on self-test screen, press F8 to specify a temporary boot
device for the Windows installation.

The Please Select Boot Device menu appears.

Note – The dialog that appears in your installation might differ depending on the
type of disk controller installed in your server.
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4. In the Please Select Boot Device menu, select the menu option according to the
Windows media installation method you elected to use, then press Enter.

For example:

■ If you elected to use the Windows local delivery method, select TEAC as the
physical DVD device (or select CD/DVD if this option is shown in boot device
dialog).

■ If you elected to use the Oracle ILOM Remote Console delivery method, select
Virtual CDROM.

5. When prompted with Press any key to boot from CD, press any key.

The Windows installation wizard starts.

Continue the Windows installation wizard until the Installation Type dialog
appears.
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6. In the Installation Type dialog, click Custom (advanced).

The Where Do You Want to Install Windows dialog appears.
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7. In the Where Do You Want to Install Windows dialog, perform one of the
following tasks in the table below to specify a storage target for the Windows
Server operating system edition.

8. (Load HBA Storage Driver) In the Load Drive dialog, do the following:

For Windows Server Edition Task

Windows Server 2008 SP2
(or subsequent Windows 2008
SP release)

Perform one of the following:
• If you do not see any storage targets listed and have

a Sun Storage SAS PCIe RAID HBA option
configured on your server, click Load Driver then
proceed to Step 8.
- or -

• If you see the storage target where you want to
install the operating system but want to change the
default partition settings associated with that target,
select the target, click Drive Options, then
proceed to Step 9.
- or -

• If you see the storage target where you want to
install the operating system and do not want to
change the default partition settings for that target,
select the target and click Next, then proceed to
Step 10.

Windows Server 2008 R2
(or subsequent Windows 2008
R2 release)

Perform one of the following:
• If you see the storage target where you want to

install the operating system but want to change the
default partition settings associated with that target,
select the target, click Drive Options, then
proceed to Step 9.
- or -

• If you see the storage target where you want to
install the operating system and do not want to
change the default partition settings for that target,
select the target and click Next, then proceed to
Step 10.
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a. Ensure the storage driver(s) are accessible according to the installation
method chosen (described in Appendix A).

For example:

■ Floppy Disk Local. Storage driver(s) on a floppy disk in floppy drive A on
the server.

■ Floppy Disk Remote. Storage driver(s) on a floppy disk in a floppy drive
mounted as a device from the Oracle ILOM Remote Console.

■ Floppy Image. Storage driver floppy.img file is mounted as a device from
the Oracle ILOM Remote Console.

■ Non-floppy Media. Storage driver(s) are on a local physical storage media
(USB flash drive or CD/DVD) or virtual media mounted from the Oracle
ILOM Remote Console.

b. In the Load Driver dialog, click Browse to navigate to the appropriate driver
media folder.

■ For systems configured wit the SAS PCIe HBA option card SG-SAS6-R-INT-
Z, navigate to the following directory to load the appropriate LSI driver:
windows/w2k8/drivers/64bit/hba/lsi/megaraid

■ For a system configured with either of these SAS PCIe HBA option
cards—SG-SAS6-INT-Z or SG-SAS6-EXT-Z, navigate to the following
directory to load the appropriate driver:
windows/w2k8/drivers/64bit/hba/lsi/mpt2
Chapter 3 Installing Windows Server 2008 19

windows/w2k8/drivers/64bit/hba/lsi/megaraid
windows/w2k8/drivers/64bit/hba/lsi/mpt2


c. In the Browse for Folder dialog, select the appropriate driver, then click OK
to load the driver.

The selected driver appears in the Select the Driver to Be Installed dialog.
Example dialogs follow showing a selected mass storage driver for a SAS PCIe
HBA.
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d. In the Select the Driver to Be Installed dialog, click Next to install the
driver.

The Where Do You Want to Install Windows dialog appears.
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e. In the Where Do You Want to Install Windows dialog, do one of following:

■ Select the storage target listed and click Next to install the operating
system, then proceed to Step 10.

- or -

■ Select the storage target listed and click Drive Options (Advanced) to
view and change the default partition settings, then proceed to Step 9.

The partition settings for the selected target appear at the bottom of the
Where Do You Want to Install Windows dialog.

9. (Partition Drive, advanced) In the lower portion of the Where Do You Want to
Install Windows dialog, do the following:
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a. Click Delete to delete the selected storage target existing partition
configuration.

A confirmation window appears.

b. Click OK to confirm the partition deletion.

c. Click New to create a new partition on the selected storage target.

d. In the Size scroll box, increase or decrease the partition size as needed, then
click Apply.

The partition is created.

e. Click Next to install the operating system to the selected storage target.

10. The Windows installation program begins and will reboot the server multiple
times during the installation process.

11. When the Windows installation is complete, Windows starts and prompts you
to change the user password.

12. In the user password dialog, click OK and set up the initial user login account.
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Note – Windows Server 2008 enforces stronger password schemes for user accounts.
Password standards include restrictions on length, complexity, and history. For more
details, click the Accessibility link at the account creation page.

After the initial user account is created, the Windows Server 2008 desktop
appears.

13. Proceed to Chapter 4 to perform the post installation tasks.

Windows Server Installation Using a
PXE Network Boot
This section explains the initial information you will need to install the Windows
Server 2008 (SP2 or R2) operating system over an established PXE-based network
using a customer-provided Windows Imaging Format (WIM) image.

Topics included in this section:

■ “Before You Begin” on page 24

■ “Install Windows Server 2008 (SP2 or R2) Using PXE Network Boot” on page 25

Note that the procedure presented in this section documents the initial steps to
install Windows Server 2008 over the network using a Windows Deployment
Services (WDS). Specifically, it explains the steps for selecting the server PXE
network interface card that will communicate with your WDS installation server. For
further information about using WDS to install the Windows Server 2008 operating
system, see Microsoft’s Windows Deployment Services documentation.

Before You Begin
■ To use PXE to boot the installation media over the network, you must:

■ Configure the network (NFS, FTP, HTTP) server to export the installation tree.

■ Configure the files on the TFTP server that are necessary for PXE booting.

■ Configure the server’s MAC network port address to boot from the PXE
configuration.

■ Configure Dynamic Host Configuration Protocol (DHCP).

■ To use WDS to perform the installation, you must:

■ Add the required system device drivers to the install.wim image and, if
necessary, the boot.wim image.
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For guidelines for adding drivers to the WIM installation image(s), see
Appendix D.

■ Obtain the WIM Administrator password.

▼ Install Windows Server 2008 (SP2 or R2) Using PXE
Network Boot
1. Reset or power on the server.

Note – The following steps use Oracle ILOM 3.1 command syntax. If you are using
Oracle ILOM 3.0, refer to the Oracle ILOM 3.0 Documentation Collection at
http://www.oracle.com/pls/topic/lookup?ctx=ilom30.

For example:

■ From the Oracle ILOM web interface, select Host Management > Power
Control in the navigation tree. Then, select Power Cycle from the Select Action
list box and click Save.

■ From the local server, press the Power button (approximately 1 second) on the
front panel of the server to turn off the server, then press the Power button
again to power on the server.

■ From the Oracle ILOM CLI, type: reset /System

The BIOS screen appears.

Note – The next events occur very quickly; therefore, focused attention is needed
for the following steps. Watch carefully for these messages as they appear on the
screen for a brief time. You might want to enlarge the size of your screen to eliminate
scroll bars.

2. Press F8 to specify a temporary boot device.

The Please Select Boot Device menu appears.

3. In the Please Select Boot Device menu, select the appropriate PXE installation
boot device and press Enter.

The PXE installation boot device is the physical network port configured to
communicate with your network installation server.

The Boot Agent dialog appears.

4. In the Boot Agent dialog, press F12 for a network service boot.
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5. Continue the normal Windows Server 2008 SP2 or 2008 R2 WDS network
installation.

For additional information, consult Microsoft’s Windows Deployment Services
product documentation.

6. When the installation completes, proceed to Chapter 4 to perform the post
installation tasks.
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CHAPTER 4

Post Installation of Windows Server
2008

After completing the installation of the Windows Server 2008 (SP2 or R2) operating
system and rebooting the server, you should review the following post installation
tasks and, if necessary, perform the tasks that are applicable to your server.

■ “Installing Critical Device Drivers and Supplemental Software” on page 28

■ “Installing Supplemental Software” on page 29

■ “Configuring Support for TPM” on page 31

■ “Configuring Intel NIC Teaming” on page 31

Before You Begin
The procedures in this chapter assume that you have:

■ Installed the Microsoft Windows Server operating system

■ Obtained a copy of the Tools and Drivers firmware DVD

If you do not have a copy of the tools and drivers firmware, you can download
the latest tools and drivers firmware from the My Oracle support site. For
Instructions see, Chapter 5.
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Installing Critical Device Drivers and
Supplemental Software
An installation wizard is provided on the Tools and Drivers firmware DVD to install
server-specific device drivers and Supplemental Software. The server-specific device
drivers are provided to support optional hardware devices that can be installed on
your server.

▼ Install Server-Specific Device Drivers
1. Insert the Tools and Drivers firmware DVD into a local or remote USB DVD

drive and do one of the following:

■ If the DVD automatically starts, click Install Drivers and Supplement
Software.

■ If the DVD does not automatically start, navigate to one of the following
folders containing the appropriate InstallPack file (for example,
InstallPack_1_0_1.exe), and double-click it.

■ <DVD>/Windows/W2K8/Packages

■ <DVD>/Windows/W2K8R2/Packages

The Server Installation Package dialog appears.

2. In the Install Pack dialog, click Next to accept the default installable items.

Note – You should always accept the “default installable items” to ensure that the
most recent versions of the drivers are installed.

The Install Pack notice dialog appears.

3. In the Install Pack notice dialog, read the message, then click Next.

The Welcome to the Sun Fire Installation Wizard appears.

4. In the Welcome to the Sun Fire Installation Wizard dialog, click Next.

The End User License Agreement page appears.

5. In the End User License Agreement page, select I Accept This Agreement,
then click Next.

The platform-specific drivers are installed. A green check mark verifies that each
driver was installed successfully.
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6. In the Driver Installation Pack dialog, click Finish.

The System Settings Change dialog appears.

Note – If you plan on installing Supplemental Software (highly recommended), do
not restart your system at this time. Once the Supplemental Software has been
installed, you will be prompted to restart the system.

7. Perform one of the following:

■ If you accepted the default installable settings in Step 2, click No to proceed
to “Installing Supplemental Software” on page 29.

■ If you are not installing the Supplemental Software, click Yes to restart your
computer.

Installing Supplemental Software
There are several Supplemental Software components available for your Sun Server
X2-4. You have two options for installation:

■ Typical. Installs all Supplemental Software applicable for your server.

■ Custom. Installs only the Supplement Software selected for installation.

TABLE 4-1 identifies the optional Supplemental Software components available for
your server.

TABLE 4-1 Install Pack Optional Supplemental Software

Available Supplemental Software Components

Servers With LSI
Integrated RAID

Controller

Servers With Intel
Integrated Disk

Controller

LSI MegaRAID Storage Manager, click Yes to restart your
computer
Enables you to configure, monitor, and maintain RAID on the SAS
internal RAID host bus adapter.

Typical Not applicable

IPMItool command-line utility
The IPMItool command-line utility reads the sensor data repository
(SDR) and displays sensor values, system event log (SEL), and field-
replaceable unit (FRU) inventory information; gets and sets LAN
configuration parameters; and performs chassis power control
operations via the BMC, which is also called the service processor
(SP).

Typical Typical
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▼ Install the Supplemental Software

Caution – If you have already installed the Supplemental Software, running the
installation again will not necessarily reinstall the Supplemental Software. It might
result in the components being removed. Carefully review the dialog boxes during
Supplemental Software installation to ensure that the results are as expected.

1. Do one of the following:

■ If you did not select the Supplemental Software when you ran the procedure
“Installing Critical Device Drivers and Supplemental Software” on page 28,
refer back to that procedure and run it again, but this time accept the default
settings in Step 2 (the default is to install the Supplemental Software), and
select No in Step 7. Then proceed to Step 2 of this procedure.

■ If you did select Supplemental Software at the Server Installation Package
dialog box in Step 2 of “Installing Critical Device Drivers and Supplemental
Software” on page 28, and selected No in Step 7, the Install Pack Supplemental
Software dialog appears. Proceed to Step 2 of this procedure.

2. In the Install Pack Supplemental Software dialog, click Next to accept the
typical settings; or select Custom to choose the options to install (see
descriptions of the Supplemental Software in TABLE 4-1).

The Component Installation wizard will guide you through the installation of
each of the selected Supplemental Software components.

3. After the Supplemental Software has been installed, click Finish.

4. Click Yes at the System Setting Change dialog to restart your system.

If you ran the Sun Server Installation Package software from the Tools and
Drivers firmware DVD, remove the DVD from your system.

Intel NIC Teaming
Enables the network interfaces on a server to be grouped together
into a team of physical ports called a virtual interface.

Typical Typical

TABLE 4-1 Install Pack Optional Supplemental Software (Continued)

Available Supplemental Software Components

Servers With LSI
Integrated RAID

Controller

Servers With Intel
Integrated Disk

Controller
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Configuring Support for TPM
If you intend to use the Trusted Platform Module (TPM) feature set that is provided
in Windows Server 2008, you must configure your server to support this feature. For
instructions, see the service manual for your server:

■ Sun Server X2-4 Service Manual

Note – TPM enables you to administer the TPM security hardware in your server.
For additional information about implementing this feature, refer to the Windows
Trusted Platform Module Management documentation provided by Microsoft.

Configuring Intel NIC Teaming
For more information on setting up NIC teaming for your environment, refer to the
Intel Connectivity web page on Advanced Networking Services Teaming at:

http://support.intel.com/support/network/sb/CS-009747.htm

Additionally, you can download the complete set of Intel Network Connections User
Guides for your server’s network adapters at:

http://support.intel.com/support/network/sb/cs-009715.htm
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CHAPTER 5

Getting Server Firmware and
Software

This section explains the options for accessing server firmware and software.

■ “Firmware and Software Updates” on page 33

■ “Firmware and Software Access Options” on page 34

■ “Available Software Release Packages” on page 34

■ “Accessing Firmware and Software” on page 35

■ “Installing Updates” on page 39

Firmware and Software Updates
Firmware and software, such as hardware drivers and tools for the server, are
updated periodically. These are made available as a software release. The software
release is a set of downloads (patches) that includes all available firmware, hardware
drivers, and utilities for the server. All these have been tested together. The ReadMe
document that is included with the download explains what has changed and what
has not changed from the prior software release.

You should update your server firmware and software as soon as possible after the
software release becomes available. Software releases often include bug fixes, and
updating ensures that your server software is compatible with the latest server
firmware and other component firmware and software.

The ReadMe file in the download package contains information about the updated
files in the download package, as well as bugs that are fixed with the current release.
The product notes also provide information about which server software versions
are supported.
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Firmware and Software Access Options
Use one of the following options to obtain the latest set of firmware and software for
your server:

■ Oracle Hardware Installation Assistant – Oracle Hardware Installation Assistant
is a factory-installed feature for the Sun Server X2-4 that allows you to easily
update server firmware and software.

■ For more information about Oracle Hardware Installation Assistant, refer to the
Oracle Hardware Installation Assistant 2.5 User’s Guide for x86 Servers at
http://www.oracle.com/pls/topic/lookup?ctx=hia.

■ My Oracle Support – All system firmware and software are available from the
My Oracle Support web site.

For more information about what is available on the My Oracle Support web site,
see http://support.oracle.com.

For instructions on how to download software releases from My Oracle Support,
see “Download Firmware and Software Using My Oracle Support” on page 35.

■ Physical Media Request (PMR) – You can request a DVD that contains any of the
downloads (patches) that are available from My Oracle Support.

For information see, “Requesting Physical Media” on page 36.

Available Software Release Packages
Downloads on My Oracle Support are grouped by product family, then product,
then version. The version contains one or more downloads (patches).

For servers and blades, the pattern is similar. The product is the server. Each server
contains a set of releases. These releases are not true software product releases, but
rather are releases of updates for the server. These updates are called software
releases and comprise several downloads, all tested together. Each download
contains firmware, drivers, or utilities.

My Oracle Support has the same set of download types for this server family as
shown in the following table. These can also be requested through a physical media
request (PMR).
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Accessing Firmware and Software
This section covers instructions for downloading or requesting software release files.
See:

■ “Download Firmware and Software Using My Oracle Support” on page 35

■ “Requesting Physical Media” on page 36

▼ Download Firmware and Software Using My
Oracle Support
1. Navigate to the following web site: http://support.oracle.com.

2. Sign in to My Oracle Support.

3. At the top of the page, click the Patches and Updates tab.

The Patches and Updates screen appears.

4. In the Search screen, click Product or Family (Advanced).

The screen appears with search fields.

Package Name Description
When to Download This
Package

X4470 M2 SERVER SW 1.3 –
ILOM_AND_BIOS

Oracle ILOM and BIOS You need the latest
platform firmware.

X4470 M2 SERVER SW 1.3 –
ORACLE_HARDWARE_
INSTALLATION_ASSIST
ANT

Oracle Hardware
Installation Assistant
recovery and ISO update
image.

You need to manually
recover or update Oracle
Hardware Installation
Assistant.

X4470 M2 SERVER SW 1.3 –
TOOLS_DRIVERS_AND_
FIRMWARE_DVD

Includes the tools and
drivers and platform
firmware. This DVD
image does not include
Oracle VTS.

You need to update a
combination of system
firmware and OS-specific
software.

X4470 M2 SERVER SW 1.0 –
DIAGNOSTICS

Oracle VTS diagnostics
image.

You need the Oracle VTS
diagnostics image.
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5. In the Product field, select the product from the drop-down list.

Alternatively, type a full or partial product name (for example, Sun Server X2-4)
until a match appears.

6. In the Release field, select a software release from the drop-down list.

Expand the folders to see all available software releases.

7. Click Search.

The software release comprises a set of downloads (patches).

See “Available Software Release Packages” on page 34 for a description of the
available downloads.

8. To select a patch, click the check box next to the patch name. (You can use the
Shift key to select more than one patch.)

A pop-up action panel appears. The panel contains several action options.

9. To download the update, click Download in the pop-up panel.

The File Download dialog box appears.

10. In the File Download dialog box, click on the patch zip file.

The patch file downloads.

Requesting Physical Media
If your processes do not allow downloads from Oracle web sites, you can access the
latest software release through a physical media request (PMR).

The following table describes the high-level tasks for making a physical media
request and provides links for further information.

Gathering Information for the Physical Media Request
You must have a warranty or support contract for your server in order to make a
physical media request (PMR).

Description Link

Gather information you will need to
provide for the request.

“Gathering Information for the Physical Media
Request” on page 36

Make the physical media request either
online or by calling Oracle Support.

“Request Physical Media (Online)” on page 37
“Request Physical Media (By Phone)” on
page 38
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Before you make the PMR, gather the following information:

Obtain product name, software release version, and patches required. It will be
easier to make the request if you know the latest software release and the name of
the download packages (patches) that you are requesting.

■ If you have access to My Oracle Support – Follow the instructions in “Download
Firmware and Software Using My Oracle Support” on page 35 to determine the
latest software release and view available downloads (patches). After viewing the
list of patches, you can navigate away from the Patch Search Results page, if you
do not want to continue with the download steps.

■ If you do not have access to My Oracle Support – Use the information in “Available
Software Release Packages” on page 34 to determine which packages you want,
then request those packages for the latest software release.

■ Have the shipping information ready. You will need to provide a contact, phone
number, email address, company name, and shipping address as part of the
request.

▼ Request Physical Media (Online)
Gather the information described in “Gathering Information for the Physical Media
Request” on page 36 before making the request.

1. Go to the following web site: http://support.oracle.com.

2. Sign in to My Oracle Support.

3. Click on the Contact Us link in the upper right corner of the page.

4. In the Request Description section, fill in the following:

a. In the Request Category drop-down menu, select the following:

Software and OS Media Requests

b. In the Request Summary field, type: PMR for latest software release
for Sun Server X2-4.

5. In the Request Details section, answer the questions shown in the following
table:

Question Your Answer

Is this a physical software media shipment
request?

Yes

Which product line does the media request
involve?

Sun Products
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6. Fill in the Ship-To contact, phone number, email address, company name, and
shipping address information.

7. Click Next.

8. In the Upload Files, Relevant Files screen, click next.

You do not need to supply any information.

9. In the Related Knowledge screen, review Knowledge Articles applicable to
your request.

10. Click Submit.

▼ Request Physical Media (By Phone)
Gather the information described in “Gathering Information for the Physical Media
Request” on page 36 before making the request.

1. Call Oracle support, using the appropriate number from the Oracle Global
Customer Support Contacts Directory at:

http://www.oracle.com/us/support/contact-068555.html

2. Tell Oracle support that you want to make a physical media request (PMR) for
the Sun Server X2-4.

■ If you are able to access the specific software release and patch number
information from My Oracle Support, provide this information to the support
representative.

Are you requesting a required password
for a patch download?

No

Are you requesting a patch on CD/DVD? Yes

If requesting a patch on CD/DVD, please
provide the patch number and
OS/platform?

Enter the patch number for each download
that you want from the software release.

List the product name and version
requested for the physical media
shipment?

Product Name: Sun Server X2-4
Version: Latest software release number

What is the OS/platform for the requested
media?

If you are requesting OS-specific downloads,
specify the OS here. If you are requesting
system firmware only, enter Generic.

Are any languages required for this
shipment?

No

Question Your Answer
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■ If you are unable to access the software release information, request the latest
software release for the Sun Server X2-4.

Installing Updates
The following sections provide information about installing firmware and software
updates:

■ “Installing Firmware” on page 39

■ “Installing Hardware Drivers and OS Tools” on page 40

Installing Firmware
Updated firmware can be installed using one of the following:

■ Oracle Hardware Installation Assistant – Oracle Hardware Installation Assistant
can download and install the latest firmware from Oracle.

■ For more information about Oracle Hardware Installation Assistant, refer to the
Oracle Hardware Installation Assistant 2.5 User’s Guide for x86 Servers at:
http://www.oracle.com/pls/topic/lookup?ctx=hia

■ Oracle Enterprise Manager Ops Center – Ops Center Enterprise Controller can
automatically download the latest firmware from Oracle, or firmware can be
loaded manually into the Enterprise Controller. In either case, Ops Center can
install the firmware onto one or more servers, blades, or blade chassis.

For more information, go to:
http://www.oracle.com/us/products/enterprise-
manager/044497.html

■ Oracle Hardware Management Pack – The fwupdate CLI Tool within the Oracle
Hardware Management Pack can be used to update firmware within the system.

For more information, refer to the Oracle Hardware Management Pack
Documentation Library at:
http://www.oracle.com/pls/topic/lookup?ctx=ohmp

■ Oracle ILOM – Oracle ILOM and BIOS firmware are the only firmware that can
be updated using either the Oracle ILOM web interface or the command-line
interface.

For more information, refer to the Oracle Integrated Lights Out Manager (ILOM)
3.0 Documentation Library at:
http://www.oracle.com/pls/topic/lookup?ctx=ilom30
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You can access the Oracle Integrated Lights Out Manager (ILOM) 3.1
Documentation Library at:
http://www.oracle.com/pls/topic/lookup?ctx=ilom31

Installing Hardware Drivers and OS Tools
Updated hardware drivers and operating system (OS)-related tools, such as Oracle
Hardware Management Pack, can be installed using the Oracle Enterprise Manager
Ops Center. For more information, go to:
http://www.oracle.com/us/products/enterprise-manager/044497.html
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PART II Windows Server System Administrator
References

Refer to the following system administrator references as needed to perform or
complete the installation of the Windows Server 2008 (SP2 or R2) operating system.

Description Link

Guidelines for selecting and setting up an installation
environment for deploying the Windows Server installation
program

Appendix A

A complete list of operating systems supported on the Sun
Server X2-4 at the time of this publication

Appendix B

Instructions for ensuring that the BIOS default properties are
set prior to performing the Windows Server installation

Appendix C

Instructions for advanced users who prefer to incorporate the
server-specific drivers in a Windows Imaging Format (WIM)
file

Appendix D





APPENDIX A

Supported Installation Methods

To determine which installation method is best for you when installing the Windows
operating system on your server, consider the following options summarized in this
appendix:

■ “Console Outputs” on page 43

■ “Installation Boot Media” on page 45

■ “Installation Targets” on page 47

Console Outputs
TABLE A-1 lists the consoles you use to capture the output and input of the operating
system installation.
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TABLE A-1 Console Options for Performing an OS Installation

Console Description Setup Requirement

Local console You can install the OS and
administer the server by
attaching a local console directly
to the server SP.
Examples of local consoles
include:
• Serial console
• VGA console, with USB

keyboard and mouse

1. Attach a local console to the server.
For details, see “Attaching Cables to the Server” in the
Sun Server X2-4 Installation Guide.

2. At the Oracle ILOM prompt, type your Oracle ILOM
user name and password.

3. For a serial console connection only, establish a
connection to the host serial port by typing start
/SP/console.
The video output is automatically routed to the local
console.

For more information about establishing a connection to
the server SP, refer to the Oracle Integrated Lights Out
Manager (ILOM) 3.1 Documentation Library at:
http://www.oracle.com/pls/topic/lookup?ctx=
ilom31

You can also access the Oracle Integrated Lights Out
Manager (ILOM) 3.0 Documentation Library at:
http://www.oracle.com/pls/topic/lookup?ctx=
ilom30.

Remote console You can install the OS and
administer the server from a
remote console by establishing a
network connection to the server
SP.
Examples of remote consoles
include:
• Web-based client connection

using the Oracle ILOM Remote
Console application

• SSH client connection using a
serial console

1. Establish an IP address for the server SP.
For details, see the Sun Server X2-4 Installation Guide.

2. Establish a connection between a remote console and
the server SP:
For web-based client connection, perform these steps:
1) In a web browser, type the IP address for the server
SP; 2) log in to the Oracle ILOM web interface; 3)
redirect the video output from the server to the web
client by launching the Oracle ILOM Remote Console;
4) enable device redirection (mouse, keyboard, etc.)
using the Devices menu.
For SSH client connection, perform these steps:
1) From a serial console, establish an SSH connection
to the server SP (ssh root@ILOM_SP_ipaddress); 2)
log in to the Oracle ILOM command-line interface; 3)
redirect the serial output from the server to the SSH
client by typing start /SP/console.

For additional information about establishing a remote
connection to the ILOM SP or using the ILOM Remote
Console, see the Oracle Integrated Lights Out Manager
(ILOM) 3.0 or 3.1 Documentation Libraries.
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Installation Boot Media
You can start the operating system installation to a server by booting a local or
remote installation media source. TABLE A-2 identifies the supported media sources
and the setup requirements for each source.

TABLE A-2 Boot Media Options for Performing the OS Installation

Installation Media Description Setup Requirement

Local boot media Local boot media requires a built-in
storage device on the server, or an
external storage device attached to
the server.
Supported OS local boot media
sources can include:
• CD/DVD-ROM or USB

installation media, and, if
applicable, floppy device driver
media

1. If your server does not contain a built-in storage
device, attach the appropriate storage device to the
front or rear panel of the server.

2. For more information about how to attached local
devices to the server, see “Attaching Cables to the
Server” in the Sun Server X2-4 Installation Guide.
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Remote boot
media

Remote media requires you to boot
the install over the network. You
can start the network install from a
redirected boot storage device or
another networked system that
exports the installation over the
network using a Pre-Boot eXecution
environment (PXE).

To redirect the boot media from a remote storage
device, perform these steps:
1. Insert the boot media into the storage device, for

example:
For CD/DVD-ROM, insert media into the built-in or
external CD/DVD-ROM drive.
For CD/DVD-ROM ISO image, ensure that ISO
image(s) are readily available on a network shared
location.
For device driver floppy media, if applicable, insert
floppy media into the external floppy drive.
For device driver floppy ISO image, ensure that ISO
image, if applicable, is readily available on a
network shared location or on a USB drive.

2. Establish a web-based client connection to the server
Oracle ILOM SP and launch the Oracle ILOM
Remote Console application. For more details, see
the Setup Requirements for web-based client
connection in TABLE A-1.

3. In the Devices menu of the Oracle ILOM Remote
Console application, specify the location of the boot
media, for example:
For CD/DVD-ROM boot media, select CD-ROM.
For CD/DVD-ROM ISO image boot media, select
CD-ROM Image.
For floppy device driver boot media, if applicable,
select Floppy.
For floppy image device driver boot media, if
applicable, select Floppy Image.

For more information about the Oracle ILOM Remote
Console, see the Oracle Integrated Lights Out Manager
(ILOM) 3.0 or 3.1 Documentation Libraries.

Supported OS remote media sources
can include:
• CD/DVD-ROM installation

media, and, if applicable, floppy
device driver media

• CD/DVD-ROM ISO installation
image and, if applicable, floppy
ISO device driver media

• Automated installation image
(requires PXE boot)

TABLE A-2 Boot Media Options for Performing the OS Installation (Continued)

Installation Media Description Setup Requirement
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Installation Targets
TABLE A-3 identifies the supported installation targets you can use to install an
operating system.

Remote Boot
Media
(continued)

Note - An automated installation
image enables you to perform the
OS installation on multiple servers.
By using an automated image, you
can ensure configuration uniformity
among many systems.

Automated installations use a Pre-
boot eXecution Environment (PXE)
technology to enable the clients
without an operating system to boot
remotely to the automated install
server that performs the installation
of the operating system.

To perform the installation using PXE, perform these
steps:
1. Configure the network server to export the

installation via PXE boot.
2. Make the OS install media available for PXE boot.

Note that if you are using an automated OS
installation image, you will need to create and
provide the automated OS install image, for
example:
- Windows WDS Image
For detailed instructions for automating the
installation setup process, consult the operating
system vendor documentation.

3. To boot the installation media, select the PXE boot
interface card as the temporary boot device.

TABLE A-2 Boot Media Options for Performing the OS Installation (Continued)

Installation Media Description Setup Requirement
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TABLE A-3 Installation Targets for OS Installations

Install Target Description Setup Requirement Supported OS

Local hard disk
drive (HDD)
or
Solid state drive
(SSD)

You can choose to install the
operating system to any of the
hard disk drives or solid state
drives installed in the server.

Ensure that the HDD or SSD is properly
installed and powered-on in the server.
For more information about installing
and powering on an HDD or SDD, refer
to the Sun Server X2-4 Service Manual.

All supported
operating
systems listed in
Appendix B.

Fibre Channel
(FC) Storage
Area Network
(SAN) device

For servers equipped with Fibre
Channel PCIe host bus adapters
(HBAs), you can choose to
install the operating system to
an external FC storage device.

• Ensure that the FC PCIe HBA is
properly installed in the server.
For more information about installing
a PCIe HBA option in your server,
refer to the Sun Server X2-4 Service
Manual.

• The SAN must be installed and
configured to make the storage visible
to the host.
For instructions, refer to the
documentation supplied with the FC
HBA.

All operating
systems listed in
Appendix B.
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APPENDIX B

Supported Operating Systems

TABLE B-1 in this appendix describes the operating systems supported on the Sun
Server X2-4 at the time this document was published.

For an up-to-date list of the operating systems supported on the Sun Server X2-4, go
to the Sun x86 Servers web site and navigate to the Sun Server X2-4 page:

http://www.oracle.com/technetwork/server-storage/sun-
x86/overview/index.html

Supported Operating Systems
Oracle’s Sun Server X2-4 supports the installation and use of the following operating
systems, or a subsequent release of the operating system.

TABLE B-1 Supported Operating Systems

Operating
System Supported Version Additional Information

Linux Oracle Linux 5.5 through 6.2 (64-bit)
Oracle Unbreakable Enterprise Kernel for Linux
5.6 through 6.1
Red Hat Enterprise Linux (RHEL) 5.5 through 6.0
(64-bit)
SUSE Linux Enterprise Server (SLES) 11 SP1 (64-
bit)
SUSE Linux Enterprise Server (SLES) 11 SP2 (64-
bit)

• Sun Server X2-4
Installation Guide for
Linux Operating
Systems
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Oracle Solaris • Oracle Solaris 11 11/11
• Oracle Solaris 10 8/11
• Oracle Solaris 10 9/10

• Sun Server X2-4
Installation Guide for
Oracle Solaris
Operating System

Oracle VM
Software

• Oracle VM 2.2.1 through 3.0.3 • Sun Server X2-4
Installation Guide for
Oracle VM Software

Windows • Microsoft Windows Server 2008 SP2, Standard
Edition (64-bit)

• Microsoft Windows Server 2008 SP2, Enterprise
Edition (64-bit)

• Microsoft Windows Server 2008 SP2, Datacenter
Edition (64-bit)

• Microsoft Windows Server 2008 R2, SP1 (64-bit)
• Microsoft Windows Server 2008 R2, Standard

Edition (64-bit)
• Microsoft Windows Server 2008 R2, Enterprise

Edition (64-bit)
• Microsoft Windows Server 2008 R2, Datacenter

Edition (64-bit)

• Chapter 3

TABLE B-1 Supported Operating Systems (Continued)

Operating
System Supported Version Additional Information
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APPENDIX C

BIOS Defaults for New Installations

When installing a new operating system on a disk drive, you should verify that the
following BIOS settings are properly configured before you perform the operating
system installation:

■ System time

■ System date

■ Boot order

Verification of BIOS Factory Defaults
In the BIOS Setup Utility, you can set optimal defaults, as well as view and edit BIOS
settings as needed. Any changes you make in the BIOS Setup Utility (by pressing F2)
are permanent until the next time you change them.

In addition to using the F2 key to view or edit the system’s BIOS settings, you can
use F8 during the BIOS start-up to specify a temporary boot device. If you use F8 to
set a temporary boot device, this change is only in effect for the current system boot.
The permanent boot device specified through F2 will be in effect after booting from
the temporary boot device.

Before You Begin
Ensure that the following requirements are met prior to accessing the BIOS Setup
Utility.

■ The server is equipped with a hard disk drive (HDD) or solid state drive (SSD).

■ The HDD or SSD is properly installed in the server. For details, see the Sun Server
X2-4 Service Manual.
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■ A console connection is established to the server. For details, see “Console Options
for Performing an OS Installation” on page 44.

▼ View or Edit BIOS Settings for New Installations
1. Reset the power on the server.

Note – The following steps use Oracle ILOM 3.1 command syntax. If you are using
Oracle ILOM 3.0, refer to the Oracle ILOM 3.0 Documentation Collection at
http://www.oracle.com/pls/topic/lookup?ctx=ilom30.

For example:

■ From the Oracle ILOM web interface, select Host Management > Power
Control in the navigation tree. Then, select Reset from the Select Action list box
and click Save.

■ From the local server, press the Power button (approximately 1 second) on the
front panel of the server to turn the server off, then press the Power button
again to power on the server.

■ From the Oracle ILOM CLI, type: reset /System

The BIOS screen appears.

2. When prompted in the BIOS screen, press F2 to access the BIOS Setup Utility.

After a few moments, the BIOS Setup Utility appears.

3. To ensure that the factory defaults are set, do the following:

a. Press F9 to automatically load the optimal factory default settings.

A message appears prompting you to continue this operation by selecting OK or
to cancel this operation by selecting CANCEL.

b. In the message, highlight OK then press Enter.

The BIOS Setup Utility screen appears with the cursor highlighting the first
value in the system time field.

4. In the BIOS Setup Utility, do the following to edit the values associated with
the system time or date.

a. Highlight the values you want to change.

Use up or down arrow keys to change between the system time and date
selection

b. To change the values in the highlighted fields, use these keys:

■ PLUS (+) to increment the current value shown
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■ MINUS (-) to decrement the current value shown

■ ENTER to move the cursor to the next value field

5. To access the boot settings, select the Boot menu.

The Boot Settings menu appears.

6. In the Boot Settings menu, use the down arrow key to select Boot Device
Priority, then press Enter.

The Boot Device Priority menu appears listing the order of the known bootable
devices. The first device in the list has the highest boot priority.

7. In the Boot Device Priority menu, do the following to edit the first boot device
entry in the list:

a. Use the up and down arrow keys to select the first entry in the list, then press
Enter.

b. In the Options menu, use the up and down arrow keys to select the default
permanent boot device, then press Enter.

The device strings listed on the Boot Device Priority menu and Options menu
are in the format of: device type, slot indicator, and product ID string.

Note – You can change the boot order for other devices in the list by repeating Steps
7a and 7b for each device entry you want to change.

8. To save changes and exit the BIOS Setup Utility, press F10.

Alternatively, you can save the changes and exit the BIOS Setup Utility by
selecting Save on the Exit menu. A message appears prompting you to save
changes and exit setup.

In the message dialog, select OK, then press Enter.

Note – When using the Oracle ILOM Remote Console, F10 is trapped by the local
OS. You must use the F10 option listed in the Keyboard drop-down menu that is
available at the top of the console.
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APPENDIX D

Incorporating Device Drivers Into
Windows Server 2008 WIM Images
for Windows Deployment Services

This section is for advanced system administrators who need to incorporate
Windows Server 2008 (SP2 or R2) device drivers into Windows Imaging Format
(WIM) files.

This appendix assumes that the system administrator is using Microsoft’s Windows
Deployment Services (WDS) to deploy the installation of Windows Server 2008 (SP2
or R2) over a network.

Note – This appendix is not intended as a tutorial for WDS or Microsoft’s Windows
System Imaging Manager (WSIM). For detailed information about WDS or WSIM,
refer to Microsoft’s WDS and WSIM documentation.

Topics in this section include:

■ “Getting Started” on page 56

■ “Location of Device Drivers on Tools and Drivers Firmware DVD” on page 56

■ “Which Device Drivers to Incorporate Into WIM Image(s)” on page 57

■ “Prerequisites and Task Overview” on page 58

■ “Procedures for Incorporating Drivers Into WIM Image(s)” on page 60

■ “Create an ImageUnattend.xml Setup Script – Windows Server 2008 (SP2 or
R2)” on page 61

■ “Add Device Driver(s) to Boot WIM – Windows Server 2008 SP2 Only” on
page 65

■ “Map ImageUnattend.xml Setup Script to Windows Server 2008 (SP2 or R2)
Install Image” on page 67
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Getting Started
Topics included in this section include:

■ “Location of Device Drivers on Tools and Drivers Firmware DVD” on page 56

■ “Which Device Drivers to Incorporate Into WIM Image(s)” on page 57

■ “Prerequisites and Task Overview” on page 58

Location of Device Drivers on Tools and Drivers
Firmware DVD
TABLE D-1 identifies the location of the device driver directories on the Tools and
Drivers firmware DVD.

Note – To obtain the latest device drivers available for the Sun Server X2-4,
download the ISO image for the tools and drivers firmware from the My Oracle
support web site at: http://support.oracle.com. For instructions, see Chapter
5.

TABLE D-1 Device Driver Directory Location on Tools and Drivers Firmware DVD

Device Drivers Directory Location on Tools and Driver Firmware DVD

Intel Network Driver • For Windows 2008 R2:
windows\W2K8R2\drivers\NIC\intel

• For Windows 2008 SP2:
windows\w2K8\drivers\NIC\intel

Aspeed Driver • For Windows 2008 R2:
windows\W2K8R2\drivers\display\
aspeed

• For Windows 2008 SP2:
windows\w2K8\drivers\display\aspeed
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Which Device Drivers to Incorporate Into WIM
Image(s)
TABLE D-2 identifies the device drivers to incorporate in the Windows Server 2008
(SP2 or R2) WIM image(s). Note that the boot WIM image identified in TABLE D-2 is
only required for Windows Server 2008 SP2 installations, and the install WIM
image identified in TABLE D-2 is required for both Windows Server 2008 SP2 and
Windows Server 2008 R2 installations.

Note – To determine which SAS PCIe HBA option cards are supported and available
for purchase on the Sun Server X2-4, go to the Sun x86 Servers web site and navigate
to the Sun Server X2-4 page: http://www.oracle.com/technetwork/server-
storage/sun-x86/overview/index.html.

LSI MegRAID Driver:
• Sun Storage 6 Gb SAS PCIe RAID HBA,

SG-SAS6-R-INT-Z
• windows/w2k8/drivers/64bit/hba/lsi/m
egaraid

LSI MPT2 Driver:
• Sun Storage 6 Gb SAS PCIe HBA, SG-

SAS6-INT-Z
• Sun Storage 6 Gb SAS PCIe HBA, SG-

SAS6-EXT-Z

• windows/w2k8/drivers/64bit/hba/lsi/m
pt2

Intel ICH10 Controller • For Windows 2008 R2:
windows\W2K8R2\drivers\64bit\HBA\
intel

• For Windows 2008 SP2:
windows\w2K8\drivers\64bit\HBA\
intel

TABLE D-1 Device Driver Directory Location on Tools and Drivers Firmware DVD

Device Drivers Directory Location on Tools and Driver Firmware DVD
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Prerequisites and Task Overview
Prior to creating the device driver WIM image(s) for Windows Server 2008 (SP2 or
R2), ensure that the following tasks are completed in the order specified.

1. Install and configure the Windows Deployment Services on a server in your
network. For details, you can download Microsoft’s Windows Deployment Services
Step-by-Step Guide at:

http://www.microsoft.com/downloads/details.aspx?familyid=
14CA18B1-B433-4F62-8586-B0A2096460EB&displaylang=en.

2. Install the Windows Automated Installation Kit (WAIK). The WAIK contains
applications to mount and modify WIM images as well as applications to create
and modify XML unattended setup scripts.

Microsoft provides separate WAIK downloads for Windows Server 2008 SP2 and
Windows Server 2008 R2. The URLs for these downloads are as follows.

■ Windows Server 2008 SP2 at:
http://www.microsoft.com/downloads/details.aspx?FamilyID=
94BB6E34-D890-4932-81A5-5B50C657DE08&displaylang=en

■ Windows Server 2008 R2 at:
http://www.microsoft.com/downloads/details.aspx?familyid=
696DD665-9F76-4177-A811-39C26D3B3B34&displaylang=en

TABLE D-2 Device Drivers to Add to WIM Image(s)

Device Drivers to Incorporate

Windows Server 2008 (SP2
and R2)
Add to install.wim

Windows Server 2008 SP2
Only
Add to boot.wim

Intel Network Drivers X X

Aspeed Graphic Driver X

SAS PCIe HBA option card installed
on server:
• Sun Storage 6 Gb SAS PCIe RAID

HBA, SG-SAS6-R-INT-Z
• Sun Storage 6 Gb SAS PCIe HBA,

SG-SAS6-INT-Z
• Sun Storage 6 Gb SAS PCIe HBA,

SG-SAS6-EXT-Z

X X

Intel ICH10 Controller X
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3. Locate the Windows device drivers on the Tools and Driver firmware DVD. For
information about where the device drivers on the Tools and Drivers firmware
DVD are located, see “Location of Device Drivers on Tools and Drivers Firmware
DVD” on page 56.

4. Establish a network-shared device driver repository. For example:

■ Create a device driver repository containing the Windows Server 2008 (SP2 or
R2) device drivers.

Note that for Windows Server 2008 WDS installation environments, a device
driver repository is provided, which you can modify. For Windows Server 2003
SP2 WDS installation environments, a device driver repository is not provided
and you must manually create one. The following is an example of how you
might want to set up the directory structure for a new device driver repository:

C:\unattend\drivers\{w2K8|W2k8R2}\catalogs\vendor\version

Where:

– unattend is the unattend device driver store

– drivers is the name for device driver directory

– {W2K8 or W2K8R2} is the name for Windows Server 2008 (SP2 or R2) device
drivers directory

– catalogs is the name for Windows Server 2008 (SP2 or R2) catalog files

– vendor is the name of directory for device driver vendor

– version is the name of directory for device driver version

■ Ensure that the directories (folders) in the device driver repository are shared
and accessible to the Windows Deployment Services (WDS) during the network
installation.

For example, the device driver repository network shares referenced in this
appendix are set up as follows:

■ Extract the Windows Server 2008 device drivers on the Tools and Drivers
firmware DVD and place them into the device driver repository.

For details about where the Windows Server 2008 device drivers are located on
the Tools and Drivers firmware DVD, see “Location of Device Drivers on Tools
and Drivers Firmware DVD” on page 56.

If you do not have a copy of the tools and drivers firmware, you can download
the ISO image for the Tools and Drivers firmware. For details, see Chapter 5.

Repository Folder Network Shares

C:\Unattended\Drivers\W2K8 \\wds-server\W2K8-Drivers

C:\Unattended\Drivers\W2K8R2 \\wds-server\W2K8R2-Drivers
Appendix D Incorporating Device Drivers Into Windows Server 2008 WIM Images for Windows Deployment Services 59



The following example demonstrates the directory structure of the device
driver repository after copying a SAS PCIe HBA driver (example version
number: 1.19.2.64) from the Tools and Drivers firmware DVD to the device
driver repository:

5. Create an imageunattend.xml Setup Script for Windows Server 2008 (SP2 or
R2). For details, see“Create an ImageUnattend.xml Setup Script – Windows Server
2008 (SP2 or R2)” on page 61.

6. For Windows Server 2008 SP2 (only) installations, add the required boot device
drivers described in TABLE D-2 to boot.wim. For details about adding the device
drivers to the boot.wim, see “Add Device Driver(s) to Boot WIM – Windows
Server 2008 SP2 Only” on page 65.

7. Map the imageunattend.xml Setup Script to the Windows Server 2008 image.
For details, see “Map ImageUnattend.xml Setup Script to Windows Server 2008
(SP2 or R2) Install Image” on page 67.

8. For Windows Server 2008 SP2 and Windows Server 2008 R2 installations, add the
required device drivers described in TABLE D-2 to the install.wim image.

Procedures for Incorporating Drivers
Into WIM Image(s)
The following procedures are guidelines you can use to add device drivers to the
WIM image file(s). These procedures should be performed in the order described.

■ “Create an ImageUnattend.xml Setup Script – Windows Server 2008 (SP2 or R2)”
on page 61

■ “Add Device Driver(s) to Boot WIM – Windows Server 2008 SP2 Only” on page 65

■ “Map ImageUnattend.xml Setup Script to Windows Server 2008 (SP2 or R2) Install
Image” on page 67

Operating System Tools and Drivers Firmware DVD Device Driver Repository

Windows Server 2008
SP2

DVDDevice:\windows\
W2K8\drivers\64bit\
hba\lsi\mpt2

C:\unattend\drivers\
W2K8\lsi\1.19.2.64

Windows Server 2008 R2 DVDDevice:\windows\
W2K8R2\drivers\64bit\
hba\lsi\mpt2

C:\unattend\drivers\
W2K8R2\lsi\1.19.2.64
60 Sun Server X2-4 Installation Guide for Windows Operating Systems • September 2012



Before you Begin
Prior to performing the procedures in this section, you should ensure that all the
prerequisites as described in “Prerequisites and Task Overview” on page 58 have
been met.

▼ Create an ImageUnattend.xml Setup Script –
Windows Server 2008 (SP2 or R2)
Follow these steps to create an ImageUnattend.xml Setup Script for a Windows
Server 2008 (SP2 or R2) installation. After the Setup Script is generated, it will be
saved to the device driver repository.

Note – The ImageUnattend.xml Setup Script (in a later procedure described in
this section) will be mapped to a Windows Server 2008 (SP2 or R2) install image.
After the setup script is mapped to the install image, the install image will install the
specified device drivers during the Windows Server 2008 (SP2 or R2) network
installation.

1. Insert the Windows Server 2008 (SP2 or R2) DVD media into the DVD reader of
the system that is hosting the Windows Deployment Services.

2. Copy all the Windows Server 2008 (SP2 or R2) catalog files into the Catalogs
folder of the device driver repository.

For example:

copy DVDDrive:\source\*.clg C:\Unattend\Drivers\{WSK8|W28R2}\
Catalogs

3. Launch the Windows System Manager application and create a new
ImageUnattend.xml Setup Script by doing the following:

a. Click Start-->All Programs -->Microsoft Windows AIK -->Windows
System Image Manager.

b. In the Answer File pane, right-click and select New Answer File.

c. If a message dialog appears asking to open a new Windows image now, click
No.

4. Do the following to specify the Windows Server 2008 (SP2 or R2) Catalog file
that matches the Windows Server 2008 (SP2 or R2) edition (Standard,
Datacenter, or Enterprise) that you are installing:

a. In the Windows Image pane, right-click and select Select Windows
Image.
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b. In the Files Type list box, select Catalog files (*.clg), then click Browse to
specify the Catalogs folder in the device driver repository.

Ensure that you select the Catalog file that matches the Windows Server 2008
(SP2 or R2) edition you are installing.

For example, for Windows Server 2008 SP2 Datacenter, select:

C:\Unattend\Drivers\{W2K8|W2K8R2}\Catalogs\
install_Windows_Server_2008_SERVERDATACENTER.clg

5. Do the following to set the component packages to
pass 2 offlineServing.

a. In the Windows Image pane, click and expand the
architecture_Microsoft-Windows-
PnPCustomizationNonWinPE_version.

b. Right -click PathAndCredientials and select Add Setting to Pass 2
OfflineServing.
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6. Repeat Step 5 for each device driver you want installed during the Windows
Server 2008 (SP2 or R2) installation.

Refer to TABLE D-2 for the list of device drivers to include in the install.wim file.

7. Do the following to specify an installation key value.

a. In the Answer File pane, click and expand
2 offlineServicing,architecture_Microsoft-Windows-
PnPCustomizationsNonWinPE_version.

b. Click and expand PathAndCredentials and enter a sequence key value as
well as the UNC device driver path in the repository.

For example, to add the device driver for the Sun Storage PCIe SAS RAID HBA
option, enter:

Key 1

Path \\wds-server\W2K8-Drivers\Lsi\1.19.2.64

c. In the Credential section for each PathAndCredentials component, click
and expand the component to insert the UNC domain, logon, and password
(if required), which allow access to the device drivers stored in the repository.

For example:

Domain UNC_domain

Password UNC_password

Username UNC_username
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d. Repeat Steps 7a through 7c for each device driver you want installed during
the Windows Server 2008 (SP2 or R2) installation.

8. Validate the ImageUnattend.xml file using the Windows System Image
Manager application:

■ In the Windows System Image Manager application, click the Tools menu and
select Validate Answer File.

A message appears in the Message pane indicating that No Warnings or Errors
are found.

9. Save the .xml Setup Script as ImageUnattend.xml using the Windows
System Image Manager application:

a. In the Windows System Image Manager application, click the File menu
and select Save Answer File as.

b. Save the .xml Setup Script in the device driver repository as:

c:\Unattend\Drivers\W2K8\Catalogs\ImageUnattend.xml

c. Exit the Windows System Image Manager application.

10. The creation of the ImageUnattend.xml Setup Script is complete. Proceed to
one of the following:

■ For Windows Server 2008 R2 installation, proceed to “Map ImageUnattend.xml
Setup Script to Windows Server 2008 (SP2 or R2) Install Image” on page 67.

■ For Windows Server 2008 SP2 installations, proceed to “Add Device Driver(s)
to Boot WIM – Windows Server 2008 SP2 Only” on page 65 prior to mapping
the ImageUnattend.xml Setup Script to the install.wim image.
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▼ Add Device Driver(s) to Boot WIM – Windows Server
2008 SP2 Only

Note – If you are performing a Windows Server 2008 R2 installation, skip this
procedure. Device drivers are not required at boot time for Windows Server 2008 R2
installations.

For Windows Server 2008 SP2 installations only, perform the following steps to add
the appropriate PCIe SAS HBA LSI device driver (MegaRAID or MPT2) to the
boot.wim image. Note that if the required PCIe SAS HBA device driver (as
described in TABLE D-1 and TABLE D-2) is not added to the boot.wim image, the
Windows Server 2008 SP2 installation will fail.

1. Insert the Windows Server 2008 SP2 DVD media into the DVD reader of the
system that is hosting the Windows Deployment Services.

2. Perform the following to launch the Windows Deployment Services
Administration tool and import the Windows Server 2008 SP2 Boot WIM.

a. Click Start -->All Programs -->Windows Deployment Services.

b. Right-click Boot Images and select Add a Boot Image, then click Browse
to specify the Windows Server 2008 SP2 boot WIM file.

For example: DVDDrive:\sources\boot.wim

c. Click Open then Next.

3. To import the Windows Server 2008 SP2 boot image, click Next twice then click
Finish.

4. Disable the Windows Server 2008 SP2 boot WIM using the Windows
Deployment Services Administration:
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■ Click and expand Boot Images, right-click Microsoft Windows Server
(Setup)x64, then select Disable.

5. Launch and run the Deployment Tools Command Prompt as Administrator.

For example:

■ Click Start -->All Programs -->Microsoft Windows AIK, then right-click
Deployment Tools Command Prompt, and select Run as
Administrator.

6. In the Deployment Tools Command Prompt, perform the following:

a. Use the mkdir command to create a temporary directory mount point to
mount the Windows Server 2008 SP2 boot WIM image.

For example:

mkdir C:\Mnt

b. Use the cd command to change the directory to the folder containing the
Windows Server 2008 SP2 boot WIM.

For example:

cd DVDDrive:\RemoteInstall\Boot\x64\images

c. Use the imagex command to mount the Windows Server 2008 SP2 boot WIM
with read/write permissions to the temporary directory mount point.

For example:

imagex /mountrw boot.wim 2 C:\Mnt

d. Use the cd command to change the directory to the device driver repository
containing the Windows Server 2008 SP2 device driver for the Sun Storage 6
Gb SAS PCIe RAID HBA option (SG-SAS-R-INT-Z):

For example, to change to the directory containing the LSI device driver for the
Sun Storage 6 Gb SAS PCIe RAID HBA option (SG-SAS-R-INT-Z), type:

cd C:\Unattend\Drivers\W2K8\lsi\1.19.2.64
66 Sun Server X2-4 Installation Guide for Windows Operating Systems • September 2012



e. Use the peimg command to add the LSI MegaRAID device driver for the Sun
Storage 6 Gb SAS PCIe RAID HBA option (SG-SAS-R-INT-Z) to the
Windows Server 2008 SP2 boot WIM image.

For example, to add the LSI MegaRAID device driver for the Sun Storage 6 Gb
SAS PCIe RAID HBA option (SG-SAS-R-INT-Z), type:

peimg /INF=*.inf C:\Mnt\Windows

f. Repeat Steps 7d and 7e for each additional device driver (as described in
TABLE D-2) that is required in the boot WIM image:

■ Sun Storage 6 Gb SAS PCIe HBA option (SG-SAS-INT-Z or SG-SAS-EXT-Z)

■ Intel Network Driver

g. Use the imagex command to unmount and commit the modified Windows
Server 2008 SP2 boot WIM image.

For example:

imagex /unmount/commit C:\Mnt

7. To enable the Windows Server 2008 SP2 boot WIM image, do the following.

a. Launch the Windows Deployment Services administration tool.

Click Start-->All Programs-->Windows Deployment Services.

b. In the Windows Deployment Services (WDS) Administration tool, click and
expand Boot Images.

c. Right-click Microsoft Windows Server (Setup) x64 and select Enable.

8. The modifications to include the device drivers into the boot.wim image are
complete. Exit the Deployment Tools Command Prompt and the WDS
Administration tool, then proceed to “Map ImageUnattend.xml Setup Script to
Windows Server 2008 (SP2 or R2) Install Image” on page 67.

▼ Map ImageUnattend.xml Setup Script to Windows
Server 2008 (SP2 or R2) Install Image
Follow the steps in this procedure to map the ImageUnattend.xml Setup Script
(created in an earlier procedure in this section) to the Windows Server 2008 (SP2 or
R2) install.wim.

1. Insert the Windows Server 2008 SP2 DVD media into the DVD reader of the
system that is hosting the Windows Deployment Services.

2. Perform the following to launch the Windows Deployment Services
administration tool and import the Windows Server 2008 SP2 install WIM.

a. Click Start-->All Programs -->Windows Deployment Services.
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b. Right-click Install Images and select Add Install Image.

Note that if no image groups exist, create a new image group named Windows
Server 2008 SP2 or Windows Server 2008 R2 and click Next.

c. Click Browse to select the Windows Server 2008 SP2 Install WIM image
located at: DVDDrive:\sources\install.wim; then proceed by clicking
Open then Next.

d. Select the Windows Server 2008 (SP2 or R2) edition (Data Center, Standard,
or Enterprise) to import into Windows Deployment Services, then click Next.

e. To import the specified Windows Server 2008 (SP2 or R2) edition install
image, click Next twice, then click Finish.
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3. Launch the Deployment Tools Command Prompt as Administrator.

For example:

■ Click Start-->All Programs -->Microsoft Windows AIK, then right-click
Deployment Tools Command Prompt, and select Run as
Administrator.

4. In the Deployment Tools Command Prompt, perform the following:

a. Use the cd command to change the directory to the folder containing the
Windows Server 2008 SP2 install WIM image.

For example, the Windows Server 2008 SP2 Datacenter (x64) edition WIM
image would be located at:

cd Drive:\RemoteInstall\images\Windows Server 2008 SP2

b. Use the mkdir command to create a directory with the exact same spelling
and case as the imported Windows Server 2008 (SP2 or R2) WIM image.

mkdir install

Note – Selecting the defaults when importing the install image for Windows Server
2008 (SP2 or R2) will create an installation WIM file called install.wim.

c. Use the cd command to change the directory to the imported Windows Server
2008 (SP2 or R2) folder, then use the mkdir command to create an Unattend
directory.

For example:

cd install

mkdir Unattend

d. Use the cd command to change the directory to the Unattend directory, then
use the copy command to copy the ImageUnattend.xml Setup Script
(created in an earlier procedure in this appendix) to the Unattend directory.

For example:

cd Unattend

copy C:\Unattend\Drivers\{W2K8|W2k8R2}\Catalogs\
ImageUnattend.xml
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5. Perform the following steps to open the Windows Server 2008 (SP2 or R2) image
properties.

a. Launch the Windows Deployment Services administration tool.

Click Start-->All Programs-->Windows Deployment Services.

b. In the Windows Deployment Services (WDS) Administration tool, click and
expand the Windows Server 2008 (SP2 or R2) image group.

c. Right-click Microsoft Windows Server (SP2 or R2) and select
Properties.

6. Perform the following steps to map the ImageUnattend.xml Setup Script to
the Windows Server 2008 (SP2 or R2) image.

a. In the General Tab of the Windows Server 2008 (SP2 or R2) image properties,
check Allow image to install in unattended mode and click Select
File.

b. Browse to the following location (specified in Step 4d) then click OK.

Drive:\RemoteInstall\images\{W2K8|W2K8R2}\install\Unattend\
ImageUnattend.xml
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c. Click OK to map the ImageUnattend.xml Setup Script to the Windows
Server 2008 (SP2 or R2) WIM image.

The Windows Server 2008 (SP2 or R2) WIM image is ready to be installed using
the Windows Deployment Services.

d. Exit the Deployment Tools Command Prompt and the Windows Deployment
Services Administration tool.

7. To deploy the Windows Server 2008 (SP2 or R2), refer to the following
procedure:

“Install Windows Server 2008 (SP2 or R2) Using PXE Network Boot” on page 25.
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